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Epilepsy Warning
Please read before using this game or allowing your children to use it.
Some people are susceptible to epileptic seizures or loss of consciousness when exposed to certain flashing 
lights or light patterns in everyday life. Such people may have a seizure while watching television images or 
playing certain video games. This may happen even if the person has no medical history of epilepsy or has 
never had any epileptic seizures. If you or anyone in your family has ever had symptoms related to epilepsy 
(seizures or loss of consciousness) when exposed to flashing lights, consult your doctor prior to playing. 
We advise that parents should monitor the use of video games by their children. If you or your child 
experience any of the following symptoms: dizziness, blurred vision, eye or muscle twitches, loss of 
consciousness, disorientation, any involuntary movement or convulsion, while playing a video game, 
discontinue use IMMEDIATELY and consult your doctor.

Precautions to Take During Use
�Do not stand too close to the screen. Sit a good distance away from the screen, as far away as the length ♦♦
of the cable allows.
Preferably play the game on a small screen.♦♦
Avoid playing if you are tired or have not had much sleep.♦♦
Make sure that the room in which you are playing is well lit.♦♦
Rest for at least 10 to 15 minutes per hour while playing a video game.♦♦

This product has been rated by the Entertainment Software Rating Board. For information about the ESRB 
rating please visit www.esrb.org.

Installing the Game
Note: For system requirements, see the readme file.

To install on a PC (disc users):
Insert the disc into your disc drive and follow the on-screen instructions.
If the Autorun menu does not automatically appear, launch the installer manually in Windows® 7,  
Windows Vista™, or Windows XP by opening Start > Run, typing D:\AutoRun.exe in the text box, then 
clicking OK (substitute the correct letter of your CD/DVD-ROM drive if other than ‘D:’).
Once the game has installed you can launch it from the game’s AutoRun menu or by locating the game 
through the START menu.

To install on a PC (EA Store users):
Note: If you’d like more information about purchasing direct downloads from EA, visit  
www.eastore.ea.com and click MORE ABOUT DIRECT DOWNLOADS.
Once the game has been downloaded by EA Download Manager, click the install icon that appears and 
follow the on-screen instructions.
Launch the game (once it is installed) directly from the EA Download Manager.
Note: If you’ve already purchased a title and would like to install it on another PC, first download and install 
the EA Download Manager on the other PC, then launch the application and log in with your EA account. Select 
the appropriate title from the list that appears and click the start button to download the game.

To install on a Macintosh:
1.	� Insert the game disc into your DVD-ROM drive. A DVD icon representing the game disc appears on your 

desktop. Double-click the icon to open the game’s launcher.
2.	 Select the game’s installer icon at the bottom of the launcher to prompt the installation menu. 
3.	 Follow the on-screen instructions to complete the installation.

To install on a PC or Macintosh (third party online users):
Please contact the digital retailer through whom you purchased this game for instructions on how to install 
the game or how to download and reinstall another copy.

Starting the Game
To start the game:
For PC:
Games on Windows Vista and Windows 7 are located in the Start > Games menu and on 
earlier versions of Windows in the Start > Programs (or All Programs) menu.
For Macintosh:
Open a Finder window, select ‘Applications,’ and double-click the game’s icon.
ACCEPTANCE OF END USER LICENSE AGREEMENT AND THE SIMS 3 PATCH UPDATE 
REQUIRED TO PLAY. ACCESS TO ONLINE SERVICES INCLUDING SIMPOINTS AND DOWNLOADS 
REQUIRES AN INTERNET CONNECTION, EA ACCOUNT AND GAME REGISTRATION WITH THE 
ENCLOSED ONE-TIME USE SERIAL CODE, WHICH IS NON-TRANSFERABLE ONCE USED. 
REGISTRATION IS LIMITED TO ONE EA ACCOUNT PER SERIAL CODE. EA ONLINE PRIVACY 
POLICY AND TERMS OF SERVICE CAN BE FOUND AT WWW.EA.COM. YOU MUST BE 13+ 
TO REGISTER FOR AN EA ACCOUNT. MAC USERS MUST UPDATE TO THE LATEST VERSION 
OF THE SIMS 3 LAUNCHER TO ACCESS ONLINE SERVICES. EA MAY PROVIDE CERTAIN 
INCREMENTAL CONTENT AND/OR UPDATES FOR NO ADDITIONAL CHARGE, IF AND WHEN 
AVAILABLE. INCLUDES SOFTWARE THAT COLLECTS DATA ONLINE NECESSARY TO PROVIDE 
AND ACTIVATE IN-GAME ADVERTISING FOR ALL THE SIMS 3 PRODUCTS PREVIOUSLY OR 
HEREAFTER INSTALLED.
EA MAY RETIRE ONLINE SERVICES AFTER 30 DAYS NOTICE POSTED ON  
WWW.EA.COM/2/SERVICE-UPDATES.
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Key Commands
General Controls

Undo/Redo CTRL-Z/CTRL-Y
Cancel ESC
Toggle cheat entry window CTRL-SHIFT-C
Hide/show UI F10

Create A Sim
Rotate Sim , (comma)/. (period)
Zoom in/out mouse wheel

Build/Buy Mode
Object Placement Tools

Rotate object , (comma)/. (period)
Delete object DEL or BACKSPACE
Enable free-form placement ALT (while holding or moving an object)
Enable free-form rotation ALT (while rotating an object with the mouse)
Move object to next slot in surface M

Build Room Controls
Create room wall tool + SHIFT + drag
Fill room with wallpaper/flooring SHIFT + click 

(when using the wallpaper/flooring tool)
Rotate floor tile floor tool: , (comma)/. (period)
Toggle full/quarter tile mode CTRL-F

Movie Making Mode
Enable movie making mode TAB
Start/end video capture V
Lower/raise camera height Q/E
Roll camera counterclockwise/ clockwise SHIFT-A/SHIFT-D
Level out the camera roll SHIFT-S
Adjust focal length Z/X
Take a snapshot C

Live Mode
Sim/Household Controls

Switch to next Sim in household SPACE
Switch to (specific) Sim Click Sim portrait
Lock camera to Sim Right-click Sim portrait
Center on active Sim ENTER
Access skill journal J
Access inventory I

Time Controls
Pause game P, 0, or `
Regular/fast/ultra speed 1/2/3 (or corresponding keys on Num Pad)
Fast forward to end of interaction 4

House Controls
MacBook

Next/previous floor PG UP/PG DOWN Fn + Up Arrow/ Down Arrow
Next/previous wall mode HOME/END Fn + Left Arrow/ Right Arrow
Center on selected Sim’s lot SHIFT-ENTER

Camera Movements
Move left/right left arrow/right arrow or A/D
Move forward/back up arrow up/down arrow or W/S
Move faster SHIFT + arrows or SHIFT + A/S/W/D
Zoom in/out Z/X or =/- or Num Pad +/ Num Pad -
Rotate left/right , (comma)/. (period)
Save camera position 1 - 5 CTRL-5 - 9
Snap camera position 1 - 5 SHIFT-5 - 9
Move to camera position 1 - 5 5 - 9
Toggle cameraman mode TAB
Toggle map mode M

Gameplay Modes
Live Mode F1
Buy Mode F2
Build Mode F3
Options Mode F5

 Mac OS X Shortcuts
Toggle between windowed and full-screen view Command-Return 
Minimize the game when in full-screen mode Command-Tab

 Right and Middle Mouse Button Functionality on Mac OS X 
Some features in The Sims 3 require a right mouse button and a middle mouse button. If you have an 
Apple Mighty Mouse, you can enable the right mouse button in System Preferences > Keyboard and 
Mouse. Change the RIGHT CLICK drop down to SECONDARY BUTTON.
Most PC USB mice are supported on the Macintosh as well. The left, right, and middle mouse buttons 
are detected and work correctly when first plugged in.
If you have an Apple legacy single button mouse, or a MacBook with a Track Pad, you can emulate a 
right mouse button click by holding down the Command key while clicking the mouse button. 
To emulate the middle mouse button using a single button mouse, hold down the Control and 
Command keys while clicking the mouse button.
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Get Inspired!
The Sims™ 3 Deluxe will inspire you with its endless creative possibilities and amuse you with unexpected 
moments of surprise and mischief! Create amazingly unique Sims by customizing their appearances 
and choosing specific personality traits. Then build their houses—design everything from an exquisitely 
furnished dream home to a rundown seaside shack. Send your Sims out to explore their new neighborhood 
and meet other Sims. They can look for a job at the sports stadium, get a massage at the day spa, or meet 
a friend for a bite at the local diner. With so much to do, new quick goals like Opportunities, and rewarding 
gameplay, The Sims 3 Deluxe gives you the freedom to choose whether—or not!—to fulfill your Sims’ 
destinies and make their wishes come true.

The Sims 3
	Start a New Game
	�Choose a neighborhood from the pull-down menu, and then click the checkmark. Your 
selected neighborhood loads.

	�The first time you start the game, you can choose to either CREATE SIMS if you want to make 
your own custom Sims, or MOVE IN HOUSEHOLD if you want to move pre-made Sims from the 
library into your town and play them.

To see more info on creating custom Sims, see Create A Sim.
After completing the tutorial (or opting out of it), select CHOOSE A HOUSEHOLD to play with pre-made Sims 
who already live in your selected town.
For pre-made households, click one of the blue house buttons to read a description of the household 
members and the house and see the difficulty level, the size of their lot, and how many Simoleons they have. 
Click the SELECT button to play at the description pop-up to play that household.
Note: Once you’ve completed the tutorial, you can also choose an empty lot and build a custom home for 
your Sims. For more on building, see Build Mode on p. 17.

Saving and Loading
Every saved game represents an entire town. To save, select SAVE from the options menu. Enter a name 
for your game and select the checkmark icon. You can always return to your game or start a new one at the 
main menu.
To load a saved game, go to the main menu and select the saved game you want to play.

Options
At the Options menu you can change graphics, audio, gameplay, video capture, and music settings. Most of 
the options are self-explanatory, but a few are detailed below.
Autonomy 	 �Move the slider to the left to decrease autonomy/free will or to the right to increase it. 

The more free will Sims have, the more they choose to act on their own if you haven’t 
assigned them an action. 

Lifespan	 �Determine how long (barring any unfortunate accidents) your Sim’s life will be by 
moving the slider to the desired number of days.

Create A Sim
Creating custom Sims has never been easier! Adjust their appearance, choose their wardrobe, determine 
their personality, and pick their favorite color, music, and food. Create all kinds of Sims imaginable!

Pre-Made Sims
Choose a pre-made Sim by clicking the Pre-Made Sims button . To filter the view, click an age, gender, 
or body type. Click the Sim you want then click the checkmark. Customize your Sim further by clicking the 
buttons at the left.
Create a totally customized Sim by clicking the Basics icon 

Basics
Enter your Sim’s name, choose their gender, set their age, adjust their skin tone, and define 
their body type.

Hair
Choose your Sim’s hairstyle, hat and hair color, determine their eyebrow shape and color, and 
their facial hair (male Sims only).

Choose a 
hairstyle

Select a 
hair color

Share this 
custom content

Choose a hat or 
other headwear

Customize hair color

Adjust eyebrows 
(including shape 

and color)

Click the lock to 
choose one hairstyle 
for all clothing 
categories (locked) 
or to choose different 
hairstyles for different 
categories (unlocked)

 Looks
Choose your Sim’s head shape, adjust their ears, determine their eye color and shape, choose a 
mouth, nose, and any moles, freckles, or makeup.
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Alter and refine 
the details of 

your Sim’s face Choose a general 
face shape

Click here to 
randomize this 
face’s features

Click one of the 
circles to tinker 
with details in 
that area of the 
face

Use the sliders 
to alter specific 

features

Clothing
Choose clothing for everyday and formal occasions and select sleepwear, athletic wear and 
swimwear. Choose from tops, bottoms, outfits, shoes, and accessories.

Personality
Set your Sim’s personality traits, favorites and lifetime wish. You can also set their voice and 
write a short biography.

It’s All in the Details
Click the  to adjust specific assets. For instance, you can adjust hair color, highlights, roots, or 
tips of your Sim’s hair. Tweak your Sim’s nose by turning the tip up a bit, widening the bridge, or 
lengthening the nostrils. Click , to see which details you can play with. On the Advanced tab, click 
one of the circles to select a different area to customize.

Create A Style
Use Create A Style to change patterns and colors on your Sims’ clothing, or create a coordinated room by 
adjusting the design of wallpapers, paint, furniture upholstery, and more.

Choose a pattern type 
(i.e., Fabrics, Carpeting 
& Rugs, Paint, etc.)

The pattern and colors 
of the selected item

Click one of these buttons 
to bring up the pre-set color 
palette, color wheel, or to 
enter RGB or Hex numbers

The selected pattern is 
made of two different colors

Move this slider to change 
the tint/tone (or lightness)

Click one of the two 
buttons to adjust it

Click one of 
these icons to 
delete, share, 

or save a style

Click here 
to view only 

custom 
content

Confirm or cancel 
your changes

Click one of the main 
swatches to see the different 

colors in it

Undo/redo each 
consecutive 
adjustment

Move the 
cursor on the 

color wheel 
to choose a 

color

Matching Shoes and More
Take a color or pattern and apply it to multiple items. Say you want your Sim’s shoes to  
exactly match her dress, click your Sim’s dress, then click the pattern from her dress that you  
want to use on her shoes, and drag the pattern onto the shoes. If the shoe has more than one  
pattern, decide where you want to use that pattern. Click the checkmark to confirm 
the change. 
Once you’ve saved a pattern, you can drag colors and patterns to furniture, décor objects, and  
accessories in Build and Buy modes.
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Saving Custom Materials and Items

Once you’ve got a style of 
pattern that you’re happy with, 
you can save it to use again and 
again—just click the folder icon 
in the material category panel on 
the right

To save that particular 
item, click the folder 
icon in the upper left 

of the screen.

Unique Sims
Choose up to five traits from dozens of personality traits, favorite foods, colors, and music, and adjust your 
Sim’s voice tone and pitch.

Traits
Your Sims traits influence what they want, how they feel, and how they behave. For instance, Sims who love 
the outdoors are happiest when they’re outside. Bookworm Sims can read more quickly and write better 
novels. Sims tend to get along better with other Sims with whom they share at least one trait.
As Sims mature from babies to young adults, they gain more traits. If your Sim was very successful and 
happy in their last development stage, you may get to pick the traits. If your Sim was only moderately happy, 
their new traits may be randomly chosen; if your Sim had a miserable experience at that life stage, they may 
be assigned negative traits.

Sim Traits
Mental Physical Social Lifestyle

Absent-Minded

Artistic

Bookworm

Can’t Stand Art 

Computer Whiz

Excitable 

Genius

Green Thumb 

Handy 

Insane 

Natural Cook 

Neurotic 

Virtuoso 

Athletic

Brave 

Clumsy 

Couch Potato 

Coward

Heavy Sleeper 

Hydrophobic 

Light Sleeper 

Lucky 

Neat

Never Nude 

Slob 

Unlucky

Charismatic

Commitment Issues 

Dislikes Children

Easily Impressed 

Flirty 

Friendly 

Good Sense of Humor 

Great Kisser 

Grumpy 

Hopeless Romantic 

Inappropriate 

Loner 

Loser

Mean Spirited

Mooch 

No Sense of Humor 

Party Animal 

Schmoozer 

Snob 

Unflirty 

Ambitious

Angler

Childish 

Daredevil 

Evil 

Family-Oriented 

Frugal 

Good

Hates the Outdoors 

Hot-Headed 

Kleptomaniac 

Loves the Outdoors 

Over-Emotional 

Perfectionist 

Technophobe 

Vegetarian 

Workaholic

Favorites
Set a few favorites for your Sim. Choose grilled cheese sandwiches as their favorite food, orange as their 
favorite color, and pop as their favorite type of music. Sims tend to choose their favorites whenever possible.

Voice
Choose a voice for your Sim and adjust the pitch.
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Skills
There are ten different skills that your Sims can develop throughout their life. The higher their skill levels, 
the better they are at performing certain tasks and activities. The skills your Sims need most depends on 
the career path they choose. For the most part, the skills for a certain career are fairly logical: to become a 
world-renowned chef your Sim must excel at cooking. Other required skills may seem less obvious: on the law 
enforcement track Sims need logic skill (solving crimes may be elementary, but it takes some brain power!). 
Your Sim can obtain a skill by reading books, practicing that skill, or taking a class at one of the buildings 
in town.

Class Locations
Skills and where classes are offered to help your Sim learn them.
Skill	 Where to Take Classes
Athletic	 Stadium
Charisma	 City Hall
Cooking	 Bistro or Diner
Fishing	 Grocery Store
Gardening	 Science Lab
Guitar	 Theatre
Handiness	 Military Base
Logic	 Science Lab
Painting	 School
Writing	 Business/Journalism Office

Skill Journal
The skill journal gives an overview of each of your Sim’s skills, including the level to which that skill is 
developed, statistics pertaining to that skill, and the opportunities associated with it.
To bring up the skill journal, press J or click the skill journal button in your Sim’s skill panel.

Wishes
Every adult Sim has a Lifetime Wish, bigger accomplishments that require more time and effort to achieve 
but are hugely fulfilling. When you create a young adult or older Sim, you choose their Lifetime Wish after 
you set their Traits. For younger Sims, you choose their Lifetime Wish during the game based on their 
activities and personality.
Your Sim also has smaller everyday wishes. Promising a wish means that you lock that as a focus for your 
Sim’s life. If your Sim fulfills that wish, they earn Lifetime Happiness Points. The wishes your Sim fulfills 
shape the path of their future wishes.
Click the arrows on either side of the wish panel to cycle through available wishes. To promise a wish, click 
it. It moves into one of the four promised wish spaces. You can also cancel a wish without penalty by right-
clicking it.

Moodlets
Moodlets are temporary conditions that directly affect your Sim’s mood and behavior. Moodlets are displayed 
as icons with different images on them, and have red (if they negatively affect your Sim’s mood), green (for 
positive effects), or blue backgrounds (no effect). Hover over a Moodlet icon to see what it is and how long it 
impacts your Sim. Your Sim personality alters which Moodlets affect them and how powerful those effects are. 

Lifetime Happiness
As long as your Sim has a really high mood, they gain Lifetime Happiness every second. The higher the 
mood, the more quickly your Sim earns Lifetime Happiness points. Spend Lifetime Happiness points to 
purchase Lifetime Rewards.
To purchase Lifetime Rewards, click the Lifetime Happiness tab of the Sim Panels and then click the 
LIFETIME REWARDS button.

Careers
Careers are the best way for your Sims to earn Simoleons. Careers also get them out of the house and give 
them a chance to meet other Sims. Some careers also have different branches that your Sim can follow. For 
branching careers, when your Sim is promoted to a certain level, you can choose which branch you want 
your Sim to take.
Your Sims can find jobs by looking in the newspaper, heading online, or by visiting different locations 
around town. 
Check the mailbox for new clothing and work-related articles when your Sim joins a new profession.
Note: Sims cannot start a profession until they are young adults. 

Job Performance
Sims in better moods typically perform better at work. Your Sim will be in a better mood for work if they’re 
well rested, well fed, and have had at least some fun in the last 24 hours.
Being late for work and leaving early negatively affect your Sim’s job performance, so make sure they get to 
work on time. However, Sims always try to get to work on their own if you let them.
Some personality traits can also give Sims a boost in their chosen career. For example, a Sim who is 
athletic will have a much easier time pursuing the Professional Sports career, as well as some branches of 
law enforcement.

The Career Panel
You can see how your Sim is doing at work by clicking the Career tab to bring up the Career panel. This 
panel shows your Sim’s current position, work schedule, salary, and performance. You can also see the 
different factors that affect job performance, such as mood, skills, or relationship with your Sim’s boss. 
Hover your mouse over one of the factors for more information about it. The better your Sim is doing in each 
of their factors, the faster their performance improves. If your Sim’s performance is maxed at the end of the 
workday, they will be promoted. Be careful though, because if your Sim’s performance falls too low, they 
may get demoted or even fired!
You can also send a Sim to work or school by clicking the button (it looks like a Sim sitting at a desk) in the 
Career panel. This button only works around the time the Sim is scheduled to go to work or school.

Sim Action Options
Now you can do more than just choose which actions your Sim performs; you can determine 
how they perform them. When you assign your Sim actions that have different options, a small 
pull-down menu appears under the icon for that action in the action queue. For example, 
at work, your Sim can choose MEET COWORKERS, WORK HARD, TAKE IT EASY, and more. 
Different actions provide different benefits and penalties, so choose wisely. It is almost always 
to your advantage to choose some action for your Sim though.
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A Living World
Your Sims live in a varied and dynamic town. Heading down to the local diner for a quick bite, studying at the 
library, or fishing at the local pond is just a click away.
In addition to this freedom to move around the town, The Sims 3 also features an option called Story 
Progression. This feature helps keep your town alive and thriving. With Story Progression, your Sims’ 
neighbors’ lives progress normally. Neighbors may move away, new ones will move in, friends get 
promotions, neighbors have children, and eventually even die. Basically, life goes on! This feature helps to 
keep the neighborhood balanced. 
You can, however, choose to disable Story Progression (in the Options menu).
In Live Mode, you can click the button that looks like a skyline (or press M) to open Map View.

Click one of the filter 
buttons to show only the 
locations that apply to 
that filter

The green tag shows 
your current household, 
the orange map tag 
indicates the homes of 
Sims your Sims know, 
the blue map tag shows 
a workplace

Click one of the 
location buttons 

to have your Sim 
visit there, take a 
class, apply for a 

job, and more

Map Tags
Below are some of the tags that appear on the map and what they indicate. Mouse-over an icon to see its 
specific name.

 Your active Sim household is identified with this icon.

Venues
When your Sim enters a venue (marked with a red icon), you cannot see them or control them inside. But 
you can make choices about what they will do while they’re visiting. For example your Sim may enter the 
Grocery store to SHOP FOR GROCERIES, BECOME A PARTNER, SELL FRUITS AND VEGETABLES, ATTEND A 
FISHING CLASS, or GET A PART-TIME JOB. 

Community Lots
When your Sim visits a community lot (marked with a dark blue icon), you can see and control them while 
they are inside.

Homes and Neighbors
You can also click other Sims’ houses to go and visit them, even if your Sim doesn’t know them yet. Head 
across the street to meet the neighbors or visit a friend across town. Once your Sim is at the neighbors’, they 
can ask to come inside and make themselves at home (up to a point!).

Community Locations
Your Sim can visit a variety of town locations including parks, the beach, shops, restaurants, and more. 
Some locations are venues for your Sims to wander around and explore.
Some buildings, such as work venues, are more basic venues. You can’t poke around, although you may be 
able to choose between different options for your Sim to perform while inside.

Live Mode
Live Mode is where all of the action takes place. Your Sim gets jobs, makes friends and enemies, falls in 
love, has a family, pursues their passions, and more, all in this mode.

Main User Interface Puck
Some of the functions are outlined here, but you can hover your mouse over any icon to see what it does.

Switch to 
Map View

Zero in on 
the selected 

Sim

Show walls down/
cutaway/up Rotate view

Click the arrows 
to cycle through 
available wishes

Promised 
wishes

Day and time

Hover over this icon 
to see this Sim’s 
lifetime wish

Click one of the icons to 
choose regular, fast, or ultra 
speed; Click the last icon to 
speed through the current 
action in this Sim’s queue

The selected Sim’s 
mood and contributing 
Moodlets

Click the arrow 
icon to bring up 
the Sim Panels 
(Simology, 
Relationships, 
Career, Skills, 
Opportunities, 
Inventory, 
Lifetime 
Happiness, 
and Needs)

Go up/down 
a floor

Start/stop 
capturing 

video

Take a 
screenshot

Access Live 
Mode, Buy 

Mode, or 
Build Mode

Getting a Hand on Things in 
Live Mode
Many items can now be moved around in Live Mode. You can return books to bookshelves, place trash in the 
bin, drag small items into your Sim’s inventory, and more.

You’ll know that you can move an object when the cursor changes to include a 
small hand.
To move an object, click and hold the mouse and then drag to the new spot you’d like to 
place. An item that is currently in use cannot be moved. 

Inventory/Family Inventory
Each Sim has their own personal inventory. When a Sim picks up an object or brings it home 
from work, you will find it in their inventory. Click and drag to move objects into or out of 
their inventory.
Each household also has an inventory. Certain items go into the Family Inventory instead of 
an individual Sim’s inventory. You can access the Family Inventory in Buy mode by clicking 
the icon that looks like a cardboard box.

Cell Phone
Each Sim (except for toddlers and babies!) has their own personal cell phone in their 
inventory. When your Sim receives a call, just click your Sim and select ANSWER. To make 
calls, just go to your Sim’s inventory and click the phone icon.
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A Day in the Life
This is a living room containing some ordinary objects. Take a look at some of the ways that your Sim can 
interact with them.

Practice chess

Choose a book 
for your Sim 

to read

Light 
the candles

View the art

Turn on the TV, 
watch a specific 

channel, or 
work out

Sit or nap 
on the sofa 
(or loveseat)

Turn on the 
stereo, work 

out, or dance

Socialization
Most social interactions between Sims fall into one of these categories: Friendly, Romantic, Mean, Funny, or 
Special. Choose the type of interaction you want your active Sim to have with the other Sim, and then select 
a specific interaction from the sub-menu. Be careful: if you choose the same social over and over again, the 
other Sim may get bored.

Special Interactions
Your Sim’s personality traits grant them special interactions. For example, Sims with the good trait can choose 
BRIGHTEN SOMEONE’S DAY, while evil Sims can do a lot of normal interactions, but with an evil twist.

Relationship Panel
You can view the relationships your Sim has in the Relationship panel. If your Sim knows lots of Sims, you 
can even filter the view to see all relationships, or just relatives, friends, visitors, or co-workers.

Opportunity Comes Knocking
Opportunities are chances for your Sim to advance either their career or skills by accomplishing different 
activities. Sims are given career opportunities while they’re at work, while skill opportunities may arrive at any 
time in the form of phone calls. Sims can also check the newspaper or computer for Special Opportunities. 
Once a Sim has accepted an opportunity, they are focused on it and will not be offered another opportunity 
of that type until the first has been accomplished, abandoned, or failed. You can abandon an opportunity by 
right-clicking it in the opportunity panel.
Every skill comes with a handful of Skill Challenges that could potentially take a lifetime to complete. 
These Challenges are difficult to achieve but the payoffs make it worth it. You can view these challenges in 
the Skill Journal.
Many opportunities have time windows for completion. Your Sim often isn’t finished with an opportunity until 
it has been turned in, usually at their workplace or to the Sim who provided the opportunity.

Collecting
Sims can gather up everything from bugs to rocks, and each collected item has its own special use. 
Butterflies and beetles can be displayed in a terrarium, named, sold, or simply watched. Rocks, gems, and 
metals can be displayed in their natural state. Gems can also be cut. Fish can be collected from various 
fishing locations and mounted to show off in the house. You may cook the fish or place them in a fishbowl.

Gardening 
The more skill points your Sim has in gardening, the more options they have. Your Sim can take a class at 
the science lab, read gardening books, or watch the gardening channel to improve their skill. Working in 
the garden, of course, also improves their skill. You Sim can plan seeds, whole fruit, and vegetables found 
around town.

Cooking
Sims can start cooking as teenagers (or even earlier on the toy oven) and the more often they cook, the more 
cooking skill they acquire. Sims can also improve their cooking by watching cooking shows on TV, reading 
books on cooking, and taking classes. As your Sim gains more skill, they learn new recipes. Sims can also 
purchase new recipes at the grocery store. All recipes are stored in your Sim’s recipe book found inside the 
skill journal entry for cooking.

Surprises in Your Sims’ New Home
When your Sims move in to a bare and unfurnished new home, sometimes they get more (or less!) than 
they bargained for. Perhaps their new abode comes with its own resident ghost, or worse yet maybe it’s 
already occupied by a host of rodent residents! The real estate agency may offer to take care of this not very 
welcome “surprise” for you, but if your Sims are resourceful, they can deal with matters themselves.
Who knows, if your Sims can take care of the problems, they might even find a surprise that they might want!

Changing the Active Household
To change the active household in your current town, from the Options menu choose EDIT TOWN. Then, 
click the CHANGE ACTIVE HOUSEHOLD button. This returns you to your initial choices: create Sims, play an 
existing household in town, or move in a household.
Changing to a different household leaves your previous household to change along with the rest 
of the town. Like other households in the neighborhood, they may get new skills or relationships, 
get fired or promoted, or change in other ways. You can always change back to that household, 
but it’s likely that things will have changed while you were gone!
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Life Stages and Aging
Unless you opt to turn off aging (in the Options menu), all of your Sims will pass through several life stages 
(depending, of course, on how old they are when they start off). The stages are baby, toddler, child, teen, 
young adult, adult, and elder. 
In The Sims 3 you have the power to decide when your Sims are ready for the next age category. Ready for 
your child to become a teen? Purchase a birthday cake and throw a party! A longer childhood increases your 
chances of being able to choose the traits for your Sim, but if you’re ready to move on, go right ahead.

Family Trees
Sims not only pass on their appearances (mom’s eye and hair color, the exact shape of dad’s nose) to their 
offspring, but they can also pass on traits when traits are randomly determined. You can view your Sim’s 
family tree at the Simology tab of the Sim Panels.

What to Expect When Your Sim Is 
Expecting
A happy pregnancy is not only good for keeping mom in better spirits, it also benefits the baby, so take care 
of your expecting Sims. Keeping mom’s mood high, reading pregnancy books, and asking a doctor for advice 
helps make the pregnancy a happy one.
Sims looking to adopt can use the phone to call the adoption service, and can choose whether to adopt a 
boy or a girl. You can choose the age as well—from babies, toddlers, and children. The adoption service is 
free, too!

‘Til Death Do You Part
Sims are mortal and one thing is certain: they will eventually die (unless you turn aging off). If a Sim is 
fortunate enough to live to an advanced age, eventually they die a natural death. But some Sims meet with 
unfortunate accidents and can expire seemingly before their time. Beware of fires, drowning, starvation, and 
electrocution as all of these can end your Sim’s days prematurely.
But the death of a Sim doesn’t have to be the end of your town. Your surviving Sims will carry on, and will 
mourn the passing of their loved one. And even if the last Sim in your household dies, you can still go to Edit 
Town and choose a new household to play with.

Buy Mode
This is the place to purchase stuff to make your Sim’s life a little bit better. 
Note: For some items, such as books and food, your Sim needs to head to the shops downtown to get 
what they need.

Sorts
You can view items in the Buy Mode catalog by room or by function. You can also view items in the 
household inventory.

Object Placement Rules and Options
The Sims 3 gives you more freedom to build, decorate, and furnish as you want. Use the new grid tool and 
the ability to position furniture at angles to get just the right look.

A New Slant on Furnishing
You can also place furniture and other objects at angles to give your room a more pleasing appearance. So if 
you want to place two chairs angled towards each other or position a plant in a corner—have at it.
Note: When you use free-form object placement and free-form object rotation Sims are more likely to 
walk into objects or to be unable to reach a specific place or object. Be careful to leave enough space for 
Sims to move around.

Furnished and Unfurnished Homes
When you choose a house for your Sims to buy from Town View, you have the option of purchasing it 
FURNISHED or UNFURNISHED. 
Unfurnished homes come with only the basics, such as plumbing (bathroom and kitchen), counters, cabinets, 
and a fridge. Furnished homes cost a bit more, but feature more amenities.

Build Mode
From seaside retreats to modest downtown starter homes, whatever you want to build happens here.

Sorts
Objects are sorted similarly to room sort in Buy Mode—different categories of objects are laid out as you 
might find them on a lot.

Important Tools
Many of the tools in Build Mode are intuitive, but some may seem a bit tricky at first. These are 
explained below.

Walls
With this tool you can put up walls, even add a whole room at once, or paint and paper walls that are 
already standing.
To build walls, click the wall icon and then choose the Create Wall tool. Click the spot on the terrain or 
foundation where you want the wall to start and, while holding the mouse button down, drag out to where 
you want the wall to end. Release the mouse button here.
Note: You can create an entire room by using the Create Room tool (also under the wall sort) in the same 
way. Just click, hold, and drag out until you have the size room you want.

Terrain Paints
Add a gorgeous emerald green lawn or maybe one with a smattering of clover. Lay down tanbark, smooth a 
layer of sand, cover the ground with granite, and more.
To lay lush grass, choose the Terrain Paints sort, then the Terrain Paints brush tool. Next choose the type 
of paint you want to apply from the palette at the far right. You can also change your brush shape and size. 
Click and drag the brush tool over the terrain to apply the paint.
Note: Using more than four different terrain paints on one lot can adversely affect system performance. 

Trees, Shrubs, and Flowers
These landscaping items are all placed like Buy Mode objects. Simply click the object in the catalog that you 
want and then click a spot on the lot where you want to place it. 	

Sledgehammer
You’ve laid the foundation and added walls, but now that you look at it, you’ve constructed too close to 
street. Use this tool to quickly remove items.
To go on an obliterating spree, choose the sledgehammer tool and then use it to select items. To delete 
multiple objects, click and hold the mouse button while you drag over the stuff you want to zap.
Note: In Build Mode, to delete multiple objects, first click the type of object you want to delete and then 
drag over the rest of the items.
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Custom Content
Record video footage of your gameplay, customize the in-game music, and more.
You can also upload your creations and share them with the entire Sims community. From Sims to sofas to a 
perfectly appointed pied à terre, you can upload your masterpieces and download other players’ too.

Video Capture
Tell your own stories using the video capture feature and the online Movie tool at The Sims 3 Community. 
See Movie Making Mode on p.2. for video capture and camera controls.
Note: All videos must be 1 GB or less.
Note: Capturing video at highest or uncompressed resolution results in very large file sizes. You can 
change your video capture settings at the Options menu.

Create A Movie Tool
Use The Sims 3 Create A Movie tool to create your own movies. Use your own game footage or choose from 
a library of clips. Add a soundtrack, transitions, captions, and more!
To use your own game footage with the Movie tool:
After you’ve captured the footage, open the Game Launcher (from the Options menu). Click the MY UPLOADS 
button and, from the Uploads screen, select the footage that you want to use, and then click UPLOAD. A pop-
up window appears where you can name your video and add a description. Once you’ve done that, click OK.
Note: You must be logged in as a game registered user to access the movie tool.
From the Movies & More pull-down menu, choose CREATE A MOVIE TOOL. If you have uploaded your own 
videos and screen shots, you will see them in the Video Clips and Images tabs. Otherwise, you can use the 
libraries provided.

To preview your 
entire movie, 

beginning with the 
currently selected 

clip, click here

Drag audio here

See if an effect 
has been applied 

to this clip

Drag clips that you 
want to include in 
your movie to the 
timeline

Add a 
caption to 
a clip

Transition (if any) 
applied to this clip

You can see all of 
the details of the 

selected clip in the 
timeline here and 

even preview it

Important Note: Mac users may not be able to view videos captured in The Sims 3 on their 
computers without a video player that supports the VP6 codec. Once they have updated their game, Mac 
users will be able to upload movies to the Community site and make their own movies.
Please refer to the Readme file for more information. 

Screen Capture
Take snapshots of all of the memorable events in your Sims’ lives.

To take a snapshot, press ♦♦ C. You can also click the camera icon on the UI puck.
When you take a screen shot it is saved to your documents folder under Electronic Arts\The Sims 3\
Screenshots. Screenshots (and videos) also automatically appear in the Uploads section of the launcher.

Custom Music
You can add your own music to the custom music folder to your documents folder under 
Electronic Arts\The Sims 3\Custom Music. Then your Sims can select that music as a radio station.

View screenshots, custom 
content, and videos that 

you’ve uploaded

Share and upload objects, 
screenshots, and videos

Install and manage 
downloaded custom content

Uninstall or turn off installed 
custom content

Shop at 
The Sims 3 
Store

The Welcome screen 
includes links to your 

messages, the exchange, 
The Sims 3 Store, the 

latest news about  
The Sims 3, and more

Download software 
updates

Important Note: The Launcher functionality for the Mac version of this game does not share the 
same functionality as the PC version. To update your Mac version of The Sims 3 and enable the full launcher 
functionality found in the PC game, go to the Software Updates page of the Launcher.

Save Your Content
Once you’ve customized your content, but while you still have Create A Style open, click the folder icon in the 
window at the top left of the screen. In some cases, a pop-up asks you to classify the type of content you want 
to save (i.e., Wallpaper or Paneling). Choose the appropriate content type. A thumbnail of your customized 
item should then appear in the window at the top left of the screen with a folder icon in the corner.
Once you have saved your item, you can then choose to share it.
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Share Your Stuff
You can share Sims, Households, Lots, Patterns, Create A Style styles (designed objects), and Build and 
Buy styles.
To upload and share your stuff with The Sims 3 community, click the . A pop-up appears asking you to 
name your item and provide a description. Enter that information and then click the checkmark once the 
confirmation appears.
Once this is done, go to The Sims 3 Launcher and click the UPLOADS button. Check the boxes for the items 
that you want to share and click the UPLOAD button. After the item is successfully uploaded, it will be grayed 
out and you’ll see an icon next to it.
Note: You must be a game registered user to share content online.

Get More Stuff
You can get even more stuff for your Sims. From the launcher, visit The Exchange on the Community site to 
browse other players’ created content, or shop at The Sims 3 Store to purchase items using SimPoints.
Note: You must be a registered user to download from the store and the Exchange.

Download Other Players’ Stuff
From the Welcome screen of the launcher, click THE EXCHANGE, then click the Go to the Exchange link. 
Choose the category of content you want to download from the buttons at the left. Once you’ve selected a 
category, you can also filter your views. Once you locate the item that you want to download, click the ADD 
TO GAME button. 

Shop at The Sims 3 Store
From the Welcome screen of the launcher, click THE STORE, and then click the Go to The Store link (or visit 
The Store by going to http://store.thesims3.com). You can browse items organized by Build Mode, Buy Mode, 
or categorized as clothing or hair. Click the current colors and Materials tab to view patterns that you can 
use in Create A Style.
You must have SimPoints to make a purchase. You can purchase SimPoints directly through the Sims Store 
site with a credit card or PayPal. 

Manage Content
Install downloaded content, and upload your custom content to the community. You can also delete items 

that are stored in your Downloads Manager (once you’ve already installed them within your game or 
uploaded them to the community).

Editing Your Town
Customize your town to suit your Sims. From the Options menu, choose EDIT TOWN. Your view of the town 
changes and you have new tools:

Select Tool
Use the select tool to choose lots in the town. Map tags denote the type of lot and what actions are available 
on the lot. 
When selecting a lot, you have some combination of the following options, depending on lot type:
Evict	 Move all Sims to the clipboard, with or without a copy of their home. 
Split Up	 Send some of the members of the household to the clipboard. 
Merge With	 Combine the members of the household with another household.
Save to Library	 Place a copy of the household or lot in the library.
Share	 Save a copy to the launcher for upload. 
Change Lot Type	 Change lot types between community and residential.
Edit Details	 Edit the name and descriptions of the household or lot.
Note: If you evict all Sims from your current active household, you will no longer be able to play with 
them. You can continue editing the town, but you will need to select the CHANGE ACTIVE HOUSEHOLD button 
and select a new household before continuing to play. If you simply want to find your active household 
another house, you can use the phone, computer, or newspaper in Live Mode to move.

Move Lot Tool
With this tool you can pick up any lot in the town and move it to an empty lot elsewhere.
After you place a lot, you have the opportunity to rotate it to any suitable orientation. If there are people living 
on the lot, they must have enough funds to afford the empty lot on which they are being placed.

Build/Buy Tool
Use the Build/Buy tool to edit any unoccupied home in the game, or to build entirely new homes on empty lots.

Bulldozer Tool
Use the bulldozer tool to delete everything on a lot, converting it to an empty lot.
Note: You cannot build on or bulldoze an inhabited residential lot. If you want to alter an inhabited 
residential lot, you must first evict the current Sims.
Note: You are also free to get rid of work locations, although it will make certain careers unavailable. For 
example, if you get rid of the Science Lab, your Sims will be unable to join the Science career. 

The Clipboard
The clipboard, which appears on the left side of the screen, is temporary storage for Sims you’ve split or 
evicted from the world. Sims on the clipboard can be placed into their own home in the town using the Place 
option, or merged into an existing household using the Merge With option. Sims on the clipboard retain their 
relationships with other Sims in the town they were evicted from, However, the clipboard clears when you 
exit Edit Town mode, so be sure to place Sims back into the town before you start playing again.

The Library
The library is permanent storage for households and lots. Sims and lots in the library are available at all 
times to place into any town. Use the PLACE COPY option to copy a selected item into the town. You cannot 
edit items in the library, but can delete or share them at any time. Households created in Create A Sim, as 
well as lots/households that you share or download, are automatically placed in the library. Sims saved into 
the library lose all relationships with members of their town of origin.
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The Sims 3 Ambitions
Every Sim dreams about what they want to be when they grow up. A Firefighter? Maybe a Ghost Hunter? 
With The Sims 3 Ambitions, their dreams can come true. With new professions, Sims have work they can be 
proud of while they ”think outside of the box,” “stay on the same page” as their colleagues, and “climb the 
corporate ladder.” 
Starting The Sims 3 Ambitions is as easy as driving in the carpool lane. Check the daily newspaper, surf the 
web, or head down to your neighborhood’s newest workspaces to start your Sims on a new career path that 
keeps them busy and happy.

Getting Ambitious
If you already have saved data for The Sims 3, choose to continue your existing game from the main menu 
after installing The Sims 3 Ambitions.
When your saved game loads, place your four new venues throughout the neighborhood. Putting these 
venues in the neighborhood is key to starting new professions!

Professions
Your Sims can take up exciting new professions and jobs throughout town. The more your Sims work, the 
more responsibilities they gain and the more Simoleons they earn. Use the Job and Opportunity Trackers to 
find jobs that improve your Sim’s job experience bar and help them climb to the top.

Firefighter
After joining “the squad,” your Sim is responsible for putting out fires and saving other Sims from perilous 
crises and natural disasters. To become a firefighter, your Sim should apply at the fire department. 
It’s important for firefighters to be at the fire station during work hours to maintain the equipment and 
constantly prepare for any kind of emergency. Sims also need to maintain their athletic and handiness 
skills, which can be honed at the fire station. Finally, firefighters should befriend their fellow firefighters. 
Camaraderie is good for the station and it’s good for the town.

Ghost Hunter
Ghost hunter Sims get to banish spirits, poltergeists, and ghosts from homes and buildings throughout 
the neighborhood using the Banshee Banisher. In order to excel in this profession, your Sim must also 
use their tools to locate, capture, and collect spirits while on a job or in their free time. Head down to the 
science facility to apply for the job and return later to sell collected spirits. Spooky-loving Sims adore this 
adventurous profession, but beware: ghost hunting can be awfully frightening.

Doctor
The medically-minded Sim thrives in the doctor’s fast-paced environment. Constantly on 
the clock, doctor Sims should be ready to deal with all sorts of medical issues on very  
little sleep. Don’t wait until your Sim breaks their arm to go to the hospital. Have your Sim 
go to the hospital in town and apply to be a doctor. Stat!

Investigator
As a seasoned investigator, your Sim must stake out local hotbeds of crime, look for any 
suspicious activity, and keep the town safe. Use the local shrubbery for your Sim to spy 
on just about anyone. Not all investigator Sims are incorruptible. They can blackmail their 
fellow Sims or break into a neighbor’s home if they are in a mischievous mood. 

Architectural Designer
This profession is great for a Sim’s inner artist. Make the neighborhood more glamorous 
or make everyone else’s home look like a shack next to your Sim’s amazing mansion. Get 
your architectural designer Sim a drafting table to help improve their designing talent. Every 
job your Sim completes helps fill their portfolio and put the fun in feng shui!

Stylist
In the stylist profession, your Sim can turn a wallflower into a runway-ready rose! 
The drafting table is a place to improve your Sim’s stylin’ abilities as they research new fashion 
concepts. Stylists also need to work on their portfolio. They can do this by photographing a customer’s 
new look after giving them a stunning makeover. If your Sim owns their very own styling station, have 
them show other Sims their amazing work to encourage them to get a makeover at home. Once a Sim 
has reached level 3 in this career, they can solicit styling services. 

Self-Employed
Sims who are more interested in being their own boss and cultivating their own skills might prefer being 
self-employed. Sims with skills in inventing, gardening, fishing, sculpting, painting, writing, nectar-making, 
or photography have the opportunity to earn a steady wage and never have to call what they do a desk job. 
Have your Sim register as a self-employed worker by accessing the Jobs and Professions icon on their 
phone. After that, your Sim needs to make their way to city hall to obtain a worker’s permit.
Note: The Sims 3 World Adventures is required for using nectar-making and photography skills.

Recreation 
There’s always something for your Sim to do. Some hobbies can help improve a Sim’s Profession, while 
others are just for fun.

Inventing
Is your Sim handy and inventive? Buy scrap at the inventing workbench or at the local junkyard. Your Sim 
can create items such as toys, dabble with scraps to make new items, or modify something previously 
discovered. Once their skill level is high enough, Sims are able to detonate objects for scrap. Just be careful 
to not to set your Sim on fire! 

Sculpting
Have your Sim create marvelous works of art with their very own sculpting station! Unlock new sculpting 
materials as your Sim’s skills improve to create bigger and better sculptures.
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Lookin’ Good!
Sims now can show off their ink and give other Sims something to gawk at or  

envy. Along with the new tattoo ability, Sims can find new clothes and styles  
in Create-A-Sim.

Tattoos
Sims can show off their tattoos by using their body as a canvas. No more having to 

hide a Sim’s ink where others can’t see it!
Get tatts inked in Create-A-Sim or add them later by selecting a tattoo station. Before putting 

your Sim under the needle, there are a few things you should know. First off, Sims can have 
tattoos in a multitude of places. For example, after choosing a tattoo for your Sim’s back, you 
have the option of placing it on the neck, upper back, full, or lower back.
Once you have selected the tattoo location and the image you wish to place, change the 
colors the same way you change make-up. You may also layer the tattoos on top of one 

another. To do so, select ADVANCED MODE on the bottom right of the tab. 
Advanced Mode has multiple placement options for your Sim’s tattoo collage, allowing you 

to layer them for a unique one-of-a-kind creation that is sure to get the attention of everyone. 
The tattoo placed in the top available space is the one that appears on top of the other tattoos. Don’t forget to 
manipulate the scale and opacity.

Laundry
Sims who wear the same thing every day should wash their clothes once in a while. Even those who change 
their outfit everyday should put them through the rinse cycle! For eco-friendly Sims, there is also the option 
of hang-drying their clothes. As an added bonus, your Sims can brag about their smaller carbon footprint… 
How green is that?!
Once your Sim purchases a washing machine, dirty clothes start piling up on the floor when they change 
their outfits. Supply a hamper to keep dirty clothes tidy before giving them a good wash. Just make sure to 
keep up with your Sim’s mounting laundry. There are also added benefits to keeping up with laundry, such 
as mood improvement due to wearing clean clothes and sleeping in clean sheets.

Hangout Spots
The Sims 3 Ambitions comes with a whole new town for your Sims to live in and explore. Make sure to 
check out downtown Twinbrook; your Sims might very well find something, or someone, they were always 
looking for. Love connection at the Laundromat, anyone?

Consignment Store
Are your Sims tired of the same old stuff in their house? Do they make so much art they don’t know what to 
do with it? Well one Sim’s trash is another Sim’s treasure. Sims can now go to the consignment store and 
sell all that junk they don’t want for a small fee and get someone else’s junk for themselves! 
Head downtown to the consignment store and sell anything your Sim has made or gathered, such as 
sculptures, paintings, produce, and even fish.

Salon

Become the talk of the town after a visit to the salon for a makeover, or get that tattoo your Sim always 
wanted but knew Mom would never approve of. If your Sim is a stylist, have them provide other Sims in the 
area with a fabulous makeover.

Junkyard

Go to a junkyard to collect scrap for your Sim’s beautiful inventions, or simply hang out with 
fellow local trash-loving Sims. Dig through piles to collect scrap. 
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Performance Tips
Macintosh Software Update
An outdated version of your MacOS X system software may lead to issues with game performance. To be 
sure that you have the latest version of MacOS X, choose ‘Software Update…’ from the Apple menu and 
follow the directions to update your system software.

Problems Running the Game
�Make sure you meet the minimum system requirements for this game and that you have the latest ♦♦
drivers for your video card and sound card installed: 
For NVIDIA video cards, visit www.nvidia.com to locate and download them. 
For ATI video cards, visit www.ati.amd.com to locate and download them.
�If you are running the disc version of this game, try reinstalling DirectX from the disc. This is typically ♦♦
found in the DirectX folder on the root of the disc. If you have Internet access, you can visit www.
microsoft.com to download the latest version of DirectX.
�For PC users, if you are running the disc version of this game, try reinstalling DirectX from the disc. This ♦♦
is typically found in the DirectX folder on the root of the disc. If you have Internet access, you can visit 
www.microsoft.com to download the latest version of DirectX.

General Troubleshooting Tips
�If you have the disc version of this game and the AutoPlay screen does not automatically appear for ♦♦
installation/playing, right-click the disc drive icon found in My Computer and select AutoPlay.
�If the game is running slowly, try reducing the quality of some of the video and sound settings from the ♦♦
game’s options menu. Reducing the screen resolution can often improve performance.
�For optimum performance when playing, you may like to disable other background tasks (except the ♦♦
EADM application, if applicable) running in Windows.
�For PC users, if you have the disc version of this game and the AutoPlay screen does not automatically ♦♦
appear for installation/playing, right-click the disc drive icon found in My Computer and select AutoPlay.

Laundromat

Don’t want to spend Simoleons on purchasing a washing machine? Want to see what other Sims are 
wearing these days? Head down to the laundromat where your Sims can not only wash their clothes, but 
also socialize while waiting for the spin cycle to finish.

Fire Department 

It’s true that firefighting Sims spend time at the fire station with their coworkers and respond to disasters 
and emergencies in a shiny red fire truck, but they also get to slide down the emergency pole. 

Placing Lots
The Sims 3 Ambitions comes with new hangouts and work places. If you are starting a previously saved 
game you have the opportunity to place these new lots in any open space. Some of these lots need to be 
placed in town for certain professions. For example, the fire station needs to be placed in town if any of your 
Sims plan to become a firefighter. 

You Played the Game. Now Play the Music.
EA Soundtracks and Ringtones 
�Available at www.ea.com/eatrax

You Played the Game. Now Play the Music.
EA Soundtracks and Ringtones 
Available at www.ea.com/eatrax
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Limited 90-Day Warranty
Electronic Arts Limited Warranty
Electronic Arts warrants to the original purchaser of this product that the recording medium on which the software program(s) are recorded (the “Recording Medium”) 
and the documentation that is included with this product (the “Manual”) are free from defects in materials and workmanship for a period of 90 days from the date of 
purchase. If the Recording Medium or the Manual is found to be defective within 90 days from the date of purchase, Electronic Arts agrees to replace the Recording 
Medium or Manual free of charge upon receipt of the Recording Medium or Manual at its service center, postage paid, with proof of purchase. This warranty is limited to 
the Recording Medium containing the software program and the Manual that were originally provided by Electronic Arts. This warranty shall not be applicable and shall 
be void if, in the judgment of Electronic Arts, the defect has arisen through abuse, mistreatment or neglect. 
This limited warranty is in lieu of all other warranties, whether oral or written, express or implied, including any warranty of merchantability or fitness for a particular 
purpose, and no other representation of any nature shall be binding on or obligate Electronic Arts. If any such warranties are incapable of exclusion, then such warranties 
applicable to this product, including implied warranties of merchantability and fitness for a particular purpose, are limited to the 90-day period described above. In no 
event will Electronic Arts be liable for any special, incidental, or consequential damages resulting from possession, use or malfunction of this Electronic Arts product, 
including damage to property, and to the extent permitted by law, damages for personal injury, even if Electronic Arts has been advised of the possibility of such 
damages. Some states do not allow limitation as to how long an implied warranty lasts and/or exclusions or limitation of incidental or consequential damages so the 
above limitations and/or exclusion of liability may not apply to you. In such jurisdictions, the Electronic Arts’ liability shall be limited to the fullest extent permitted by law. 
This warranty gives you specific rights. You may also have other rights that vary from state to state.

Returns Within the 90-Day Warranty Period
Please return the product along with (1) a copy of the original sales receipt showing the date of purchase, (2) a brief description of the difficulty you are experiencing, and 
(3) your name, address and phone number to the address below and Electronic Arts will mail a replacement Recording Medium and/or Manual to you. If the product was 
damaged through misuse or accident, this 90-day warranty is rendered void and you will need to follow the instructions for returns after the 90-day warranty period. We 
strongly recommend that you send your products using a traceable delivery method. Electronic Arts is not responsible for products not in its possession.
Note: The following warranties only apply to products sold at retail. These warranties do not apply to products sold online via EA Store or third parties.

EA Warranty Information
If the defect in the Recording Medium or Manual resulted from abuse, mistreatment or neglect, or if the Recording Medium or Manual is found to be defective after 90 
days from the date of purchase, choose one of the following options to receive our replacement instructions: 
Online: http://warrantyinfo.ea.com
Automated Warranty Information: You can contact our automated phone system 24 hours a day for any and all warranty questions: 
US 1 (650) 628-1001

EA Warranty Mailing Address
Electronic Arts Customer Warranty, 9001 N I-35 Suite 110, Austin, TX 78753

Notice
Electronic Arts reserves the right to make improvements in the product described in this manual at anytime and without notice. This manual and the product described in 
this manual are copyrighted. All rights reserved.

Technical Support Contact Info
E-mail and Website: For instant access to all of our technical support knowledge, please visit http://techsupport.ea.com.
Telephone Support: Technical Support is also available from 8am to 5pm PST by calling us at (650) 628-1001. No hints or codes are available from (650) 628-1001.
Mailing Address: �Electronic Arts Technical Support
	 9001 N I-35 Suite 110, 	 Austin, TX 78753
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The Sims 3 Deluxe © 2010 Electronic Arts Inc. EA, the EA logo, The Sims and The Sims 3 logo are trademarks of Electronic Arts Inc. RenderWare is a trademark or 
registered trademark of Criterion Software Ltd. Portions of this software are Copyright 1998-2009 Criterion Software Ltd. and its Licensors. All other trademarks are the 
property of their respective owners.

Uses Granny Animation. Copyright © 1999-2010 by RAD Game Tools, Inc.
Macintosh Conversion by TransGaming Inc.
This game uses Cider™ Technology from TransGaming Inc. Cider™ is Copyright © 2000-2009 TransGaming Inc.
Cider C/C++ runtime components (msvcrt.dll, msvcr71.dll, msvcp71.dll, msvcr80.dll, and msvcp80) include portions of Visual C++ 6.0 runtime components and portions 
of Dinkum Compleat C/C++ Libraries. Visual C++ 6.0 runtime components are Copyright © 1999 Microsoft Corp. Dinkumware components are Copyright © 1989-2006 
by P.J. Plauger and Dinkumware Ltd.
Cider MFC & ATL components (MFC42.dll, MFC71.dll) include the Visual C++ 6.0 MFC & ATL components. Visual C++ 6.0 MFC & ATL components are  
Copyright © 1992-1999 Microsoft Corp.
Cider includes libpng, Copyright © 1995-2004 the libpng project authors (see http://www.libpng.org/pub/png/src/libpng-LICENSE.txt for a complete list)
This software is based in part on the work of the Independent JPEG Group. Cider includes libjpeg, copyright © 1991-1998, Thomas G. Lane.
Cider uses NVIDIA’s Cg Toolkit, Copyright © 2002-2008, NVIDIA Corporation.
Cider includes dmalloc, Copyright © 2001-2006 Wolfram Gloger
Cider includes CSRI malloc, Copyright © 1988, 1989, 1993 University of Toronto
Cider includes SDL, Copyright © 2001-2007 the SDL project authors (see http://libsdl.org/credits.php for a complete list). SDL is available under the terms of the  
GNU Lesser General Public License (LGPL) found below.
Cider includes The Better String Library (bstring) Copyright © 2002-2006 Paul Hsieh
Portions of this software are Copyright © 2006, Industrial Light & Magic, a division of Lucasfilm Entertainment Company Ltd. Portions contributed and copyright held by 
others as indicated. All rights reserved.
iniParser Portions Copyright © 2000 by Nicolas Devillard.
Portions of this software are copyright © 1996-2000 The FreeType Project (www.freetype.org). All rights reserved.
Portions of this software are copyright © 2006 Simon Brown and contributors of the Squish project (http://sjbrown.co.uk/?code=squish). All rights reserved.
The Cider libquartz.dylib component includes portions of ffmpeg, Copyright © 2000-2006 Fabrice Bellard, et al.
Cider and related components are distributed under the terms of the Cider Technology License and other licences, including the GNU LGPL. License details are available 
in the End User License agreement.
Portions of Cider are Copyright © 2002-2006 the ReWind project authors (see http://cvs.transgaming.org/cgi-bin/viewcvs.cgi/rewind/AUTHORS?root=rewind for a 
complete list).
Portions of Cider are Copyright © 1993-2008 the Wine project authors (see http://source.winehq.org/source/AUTHORS for a complete list).
Source code to the LGPL components is available through: http://transgaming.org/cvs/
Other Cider components available via CVS are licensed separately under terms described in the LICENSE files that accompany them.
This game incorporates dynamic advertisement serving technology offered by IGA Worldwide Inc. (“IGA Technology”), which enables advertising to be temporarily 
uploaded into the game on your PC or console, and replaced while you are online. IGA Technology only logs information that is needed to measure presentation of 
advertising, and to serve advertising to the appropriate geographic region and to the right location within the game. Logged data may include Internet Protocol Address 
(“IP Address”), in game location, length of time an advertisement was visible, size of the advertisements, and angle of view. The IP Address is deleted when the online 
game session ends. Your game may be assigned an id number, which is stored on your PC or console, and used by IGA Technology to calculate the number of unique 
and repeat views of dynamic in game advertising. The id number is not associated with any personal data. No logged information is used to personally identify you. This 
ad serving technology is integrated into the game; if you do not want to use this technology, do not play the game while connected to the Internet. For more information 
see our privacy policy at privacy.ea.com or visit IGA at http://www.ingameadvertising.com/.

Technical Support
If you have trouble with this game, EA Technical Support can help. 
The EA Help file provides solutions and answers to the most common difficulties and questions about how to 
properly use this product.

To access the EA Help file (with the game already installed):
Windows Vista and Windows 7 users, go to Start > Games, right-click the game icon, and select the 
appropriate support link from the drop-down menu.
For users on earlier versions of Windows, click the Technical Support link in the game’s directory located 
in the Start > Programs (or All Programs) menu.

To access the EA Help file (without the game already installed):
1. 	 Insert the game disc into your DVD-ROM drive.
2. 	Double-click the My Computer icon on the Desktop. (If the My Computer icon is not visible on your  
	 desktop, you may need to click the Start button and then click the My Computer icon).
3. 	Right-click the DVD-ROM drive that has the game disc and then select OPEN.
4. 	Open the Support > EA Help > Electronic_Arts_Technical_Support.htm file in North America or 	
	 Support > European Help Files> Electronic_Arts_Technical_Support.htm in Europe.

To access the EA Help file on a Macintosh:
1.	 Insert the game disc into your DVD-ROM drive.
2.	 Click the Finder icon in the Dock.
3.	 Open a new Finder window by choosing ‘New Finder Window’ from the File menu.
4.	 Click the game disc icon in the Finder window.
5.	 Open the Support > Electronic Arts Technical Support.html file.
If you are still experiencing difficulty after utilizing the information in the EA Help file you can contact 
EA Technical Support. 

EA Technical Support on the Internet
If you have Internet access, be sure to check our EA Technical Support website at:
http://support.ea.com
Here you will find a wealth of information on DirectX, game controllers, modems, and networks, as well as 
information on regular system maintenance and performance. Our website contains up-to-date information 
on the most common difficulties, game-specific help, and frequently asked questions (FAQs). This is the 
same information our support technicians use to troubleshoot your performance issues. We keep the support 
website updated on a daily basis, so please check here first for no-wait solutions. 

Technical Support Contact Info
If you need to talk to someone immediately, call our Technical Support team (Monday through Friday  
8 AM – 5 PM PST):
Telephone: US 1 (650) 628-1001. 
Note: No hints or codes are available from Technical Support.
Website: http://support.ea.com
Mailing Address: �EA Technical Support 

9001 N I-35 Suite 110 
Austin, TX 78753


